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END USER LICENSE AGREEMENT/WARRANTY

IMPORTANT - CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS 
OF THIS AGREEMENT.

This End User License Agreement (“Agreement”) is a legal agreement between you, the user of 
Philips’ portable computing device (“Product”), and Philips Mobile Computing Group (“Philips”), 
the manufacturer of the Product. The Product comes with certain software, and associated 
documentation, which are installed on the Product and/or included in the original Product packaging 
on external media. (All such software and documentation, but specifically excluding Microsoft 
software and documentation, are collectively referred to as “Software”.) YOU DO NOT NEED TO 
SIGN THIS AGREEMENT IN ORDER FOR IT TO TAKE EFFECT. BY INSTALLING, COPYING, OR 
OTHERWISE USING THE SOFTWARE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PHILIPS IS 
UNWILLING TO LICENSE THE USE OF THE SOFTWARE TO YOU. IN SUCH EVENT, YOU MUST 
NOT OPEN THE SEALED PRODUCT OR SOFTWARE AND MUST PROMPTLY RETURN THE 
SEALED PRODUCT AND SOFTWARE TO THE PLACE YOU OBTAINED IT FOR A FULL 
REFUND.

1. Grant of License. Philips hereby grants you the non-exclusive right to use the Software only 
as installed on the Product or, for Software which is not already installed on the Product, to 
install and use the Software on a single Product.

2. Ownership of the Software and Documentation. You do not receive title or ownership 
to the Software, but merely the limited right to use the Software as specified in this Agreement.

3. Restrictions. You may not: (i) copy the Software except for one copy for back-up, archival 
purposes provided that the copy contains all of the original Software’s proprietary notices 
and is subject to all of the terms of this Agreement; (ii) modify, translate, reverse engineer, 
decompile, disassemble (except to the extent that this restriction is expressly prohibited by 
law) the Software or create derivative works based upon the Software; (iii) rent, lease, lend, or 
sublicense the Software; (iv) or transfer the Software except together with the sale or transfer 
of the Product and then only if you keep no copy of the Software, if you transfer all of the 
Software (including back-up copies), and if the recipient agrees to comply with, and be bound 
by, the terms of this Agreement.

4. Termination. This Agreement, and the licenses granted in it, is effective until terminated. This 
Agreement will terminate: (i) automatically if you fail to comply with any of the terms of this 
Agreement; or (ii) without prejudice to any other rights, upon written notice sent to you by 
Philips if Philips, in its sole judgment, believes that the Software is being used for a purpose 
not approved by it or that its rights are being jeopardized. In such event, you must destroy all 
copies of the Software and all of its component parts immediately upon receipt of such notice.

5. Limited Warranty.

a. For a period of one (1) year from the date of purchase by you, Philips warrants that the 
Product, excluding Software, shall function in substantial conformance with the 
performance requirements set forth in the end-user documentation under normal use 
and shall be free from defects in materials or workmanship.

b. For a period of ninety (90) days from the date of purchase by you, Philips warrants: 
(i) that the Software in object code in the Product ROM (or on the removable storage 
device (“Miniature Card”) to be inserted in the miniature card socket of the Product, if 
applicable) shall function in substantial conformance with the performance requirements 
set forth in the end-user documentation under normal use; and (ii) that the media on 
which such Software is furnished shall be free from defects in materials and workmanship.

c. For a period of thirty (30) days from the date of purchase by you, Philips warrants: 
(i) that the Software in object code form on all external media shall function in substantial 
conformance with the performance requirements set forth in the end-user documenta-
tion under normal use; and (ii) that the media on which such Software is furnished shall 
be free from defects in materials and workmanship.



           
d. This Limited Warranty does not apply to the finish or cosmetic appearance of 
the Product.

e. This Limited Warranty is provided only to you, the original purchaser of the Product. 
It is not transferable by you to any other person or entity.

f. This Limited Warranty is void if failure has resulted from accident, abuse, or misapplica-
tion. Without limiting the foregoing, battery leakage, bending of the unit, a broken LCD 
display or any cracks in the LCD display will be presumed to have resulted from misuse 
or abuse.

g. Your sole and exclusive remedy in the event of a breach of warranty shall be, at Philips’ 
option, the replacement of the Product or the Software with a remanufactured or 
refurbished Product or refund of the price you paid, provided you return the Product 
to Philips together with a copy of your receipt. Should you need to take advantage of 
the Limited Warranty, contact Philips at 1-888-275-8356.

h. No person is authorized to modify this Limited Warranty or to make additional 
warranties. No action for any breach of this Limited Warranty may be commenced 
more than one (1) year following the expiration date of the warranty.

6. Warranty Disclaimer / Limitation of Liability.

a. THE FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES. 
EXCEPT AS SPECIFICALLY SET FORTH ABOVE, PHILIPS DISCLAIMS ALL 
WARRANTIES, INCLUDING WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

b. PHILIPS SHALL NOT BE LIABLE FOR ANY LOSS OF USE, DAMAGES RESULTING 
FROM MATHEMATICAL INACCURACY, LOSS OF STORED DATA, OR INDIRECT OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF, OR IN CONNECTION WITH, THE 
USE OR INABILITY TO USE THE PRODUCT OR ANY SOFTWARE EVEN IF PHILIPS 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT 
SHALL PHILIPS’ LIABILITY EXCEED THE COST OF THE PRODUCT, WHETHER YOUR 
CLAIM IS BASED ON CONTRACT, TORT, WARRANTY, OR ANY OTHER LEGAL 
THEORY. SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF IMPLIED WARRANTIES OR LIMITATION OF IMPLIED 
WARRANTIES OR LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. IF IMPLIED WARRANTIES 
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW, THEN ANY SUCH IMPLIED 
WARRANTIES ARE LIMITED IN DURATION TO NINETY (90) CALENDAR DAYS 
AFTER THE DATE OF YOUR PURCHASE OF THE PRODUCT.

7. Microsoft Software. This Agreement does not apply to Microsoft software. Your rights 
to use, and restrictions on, Microsoft software are governed by a separate end user license 
agreement, included with the Product, which applies exclusively to Microsoft software.

8. U.S. Government. Restricted Rights. Pursuant to DFARS 227.7202 and FAR 12.212, the 
Software is subject to, and restricted by, this Agreement. Use, duplication, or disclosure by the 
United States Government is governed solely by the terms and conditions contained herein.

9. Choice of Law. This Agreement is governed and construed under the laws of the State of 
California, except those portions pertaining to conflicts of law. You consent to the exclusive 
jurisdiction of the state and federal courts sitting in the State of California.

10. Entire Agreement. This Agreement constitutes the final, exclusive and complete agreement 
with you concerning the Software. It may not be amended or altered except in a written 
document signed by you and an authorized representative of Philips.
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Welcome!

Welcome to the Nino™
–the Philips Personal Companion that keeps you up-to-date when 
you’re on-the-go. 

With its unique ergonomic design and automatic 
synchronization with your primary PC, your Nino 
lets you easily and quickly find or modify your 
essential personal information—including your 
calendar, tasks, contacts, e-mail, Internet infor-
mation services (channels), and much more.

Utilizing the Microsoft® Windows® CE 
operating system for the Palm-size PC, the 
Nino also provides significant software 
extras, including T9™ Text Input from Tegic 
Communications, Pocket Commander™ 
voice-based navigation software and 
smARTwriter handwriting recognition 
software from ART, and an Expense 
Manager program. 

This guide will help you get started. 

For more detailed information, you can turn to a variety of 
resources:

■ On-line help—Select Help from the Start menu to get 
information about specific features of Nino software.

■ The Microsoft Palm-size PC User’s Guide—Look at this 
manual for a comprehensive guide to Windows CE for the Palm-
size PC.

■ The Philips Nino CD—Go to this CD for documentation 
about the extra software bundled with your Nino, as well as 
other useful information.

■ The Nino Web site at http://nino.philips.com—Visit this site for 
the latest Nino news, tips, and support information. 

■ The Microsoft Windows CE Web site at
http://www.microsoft.com/windowsce/—Visit this site for the most 
recent information about Windows CE.
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A Tour of the Nino

Indicator lights
The top light goes on when an 
alarm you’ve set is activated. 
The bottom light blinks green 
when the batteries are recharging.

On/Off-Backlight button
Press this button to turn the Nino 
on or off. Press and hold to turn 
backlighting on or off.

Dock/serial 
connector
Connects the Nino 
to the Nino Dock.

Telecom port
Connect the US 
Modem Click-on or 
the European modem 
cable here.

Quick Start buttons
Press one of these 
customizable buttons 
to turn the Nino on 
and start a particular 
program, or to switch 
instantly between 
programs.

AC adapter port
Plug in the Nino AC 
adapter here.

Contrast control
Turn this control to 
increase or decrease 
screen contrast.

Scroll up control
Press here to scroll 
up in a list. 

Action button
Functions like the 
Enter key on your PC.

Exit button 
Functions like the Escape key 
on your PC. 

Microphone 

Speaker

Scroll down control
Press here to scroll 
down in a list.

Nino front and right side

Nino left side
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Nino Dock
Place the Nino in the Nino Dock 
to synchronize information with 
your desktop PC and to 
recharge the batteries.

Stylus slot
Holds your 
Nino stylus. 

DC Input 
Jack symbol

Non-removable 
backup battery 
Maintains the integrity 
of your data.

Battery compartment
Install the rechargeable 
battery pack or AA 
batteries here.

Soft reset button
Press this recessed button to 
reset the Nino without losing 
information.

ROM upgrade compartment
Install future Operating System 
upgrades here.

CompactFlash 
data storage card 
compartment
Install a CompactFlash 
card here.

Infrared port
(at top of unit) 
Send or receive information 
wirelessly via this port.

Stylus 
Use only the Nino stylus to 
write or tap on the screen.

Other Nino components

Nino back
N I N O  O W N E R ’ S  G U I D E 3



            
First Steps with the Nino

First install the rechargeable battery pack 

You can provide power to the Nino in three ways: 1) the AC power 
adapter, 2) the Nino rechargeable battery pack, or 3) AA batteries. 
If connecting to AC power is not convenient and you would like to 
try out your Nino immediately, you can install the AA batteries, 
being careful to correctly align the positive and negative ends. Be 
aware that data you enter may not be properly maintained until the 
built-in backup battery is adequately recharged. 

Philips recommends that you first install the rechargeable battery 
pack and leave your Nino plugged in overnight. Follow these steps:

1 Open the door of the battery compartment.

2 Insert the rechargeable battery pack.

Only use the Nino rechargeable battery pack.
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3 Close the battery compartment door.

4 Plug in the Nino with the Nino AC adapter.

Only use the AC adapter provided with the Nino.

The green indicator light blinks while the rechargeable battery pack 
is charging. Leave the Nino plugged in for several hours 
(overnight is best). The indicator light goes off when the 
rechargeable battery pack is fully charged. 
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Now turn on the Nino

1 Press the On/Off button once.

The Nino Welcome screen appears. In a moment, it is replaced by 
the Windows CE Welcome screen.

2 You may want to adjust screen contrast. 

Use the control on the right side of the unit.

3 If you’d like to turn on backlighting, press and hold down the 
On/Off button again for more than one second.

4 Press the Action button.

Nino now asks you to calibrate the unit 
by tapping a sequence of screen locations. 
Tap gently but firmly. When you have completed a series of taps, 
you’ll be asked to press the Action button again.
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5 Now set your home location.

Tap the location arrow to see a list of cities. Choose your location 
(or one nearby, for the moment). Then tap OK.

6 Then set the time, using the on-screen keyboard. 

To get a colon (:), tap the Shift key.

Location arrow
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7 Then set the date. 

Tap the date arrow to display a calendar. Navigate to the correct 
month and tap on the correct day. Then tap OK. 

A message tells you, “Setup is complete.”

8 Tap once to go to the Active Desktop.

The Active Desktop can display important information such as 
your appointments and tasks for the day. Notice that your owner 
information is not yet available. It’s a good idea to provide it now.

Date arrow

Any time you want to display the 
Active Desktop, tap here. 
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9 Tap “Tap here to set Owner information.”

Use the on-screen keyboard to fill in your personal information. 
Scroll down to see all the fields available. When you’re finished, 
tap OK.

Your personal information now appears on the Active Desktop.

Some useful settings

To check the state of the rechargeable batteries and the 
built-in backup battery—Tap Start > Settings > Power.

To modify the contents of the Active Desktop—Tap Start > 
Settings > Display > Desktop tab.

To customize the Start menu—Tap Start > Settings > Taskbar 
> Start Menu Items tab.

To set one or more alarms—Tap Start > Settings > World Clock 
> Alarms tab.

To set time, date and number formats for your country—
Tap Start > Settings > Regional Settings. 

You can make the keyboard 
disappear and reappear by 
tapping here.
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Docking and Synchronizing

Now set up the Nino Dock and perform 
the initial synchronization with your PC

Place the Nino Dock in a convenient location near your desktop 
PC and then follow these steps:

1 Connect the AC adapter to the dock. 

The connection is on the bottom of the dock.

2 Then connect the dock serial cable to a serial port on your PC.

3 Put the Nino on the Nino Dock and make sure it is on.
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Installing Windows CE Services

To prepare your PC for a “partnership” with your Nino, you need 
to install Windows CE Services from the Microsoft CD.

N O T E If you will be connecting the Nino via a Remote Access 

Server (RAS), if you run the Windows NT® operating system with a 

service pack, or if you want to use the infrared connection to dock, 

you need to follow the special installation instructions in the 

Microsoft Palm-size PC User’s Guide.

Before you start, save the work on your PC and quit all programs. 
If this is the first time you are installing Windows CE Services on 
your PC, you may also need to use your Windows CD during the 
process.

1 Insert the Desktop Software for Windows CE CD in your 
CD-ROM drive.

The Windows CE Services Welcome screen appears automatically. 
(If it doesn’t, select Run from the Start menu, type d:startup, where 
d is the name of the drive with the Microsoft CD, and press Enter.) 
The Installation Wizard presents welcome and licensing 
information, asks you to fill in your name and company, and then 
choose a setup.
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2 Click the Typical option and follow the on-screen instructions. 

When you have installed the software, the Get Connected dialog 
box appears: 

3 Make sure the Nino is turned on and in the Nino dock. 
Then click Start.

It takes a few moments for the software to locate your Nino and to 
configure communication settings. When the process is finished, 
the Mobile Devices window appears on your PC screen. 

4 Wait a few moments until the New Partnership Wizard 
appears.

(If Windows CE Services fails to detect your Nino, refer to the 
section on communications settings in the Microsoft Palm-size 
PC User’s Guide.)
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5 Use the New Partnership Wizard to establish the PC-Nino 
partnership.

Fill in the device name and description (“Nino”). Leave the 
“On Connect” option checked for synchronization. This will 
synchronize your Nino each time it is connected.

6 A few moments after the partnership is established, 
ActiveSync on your PC automatically starts the initial 
synchronization process.

Information from desktop applications such as Microsoft Outlook 
is transferred to your Nino. 

During this process you may see a screen asking you to 
“Combine” or “Discard” information on the PC and the Nino. 
Choose Combine.

When initial synchronization is successfully completed, your PC 
desktop displays the Mobile Devices window with the message 
“Connected, Up-to-date” in the lower right corner.

During installation, Windows CE Services places a Mobile Devices 
shortcut on your desktop. (Mobile Devices also shows up as an 
entry in My Computer.) For details about the Mobile Devices 
program window, see the Microsoft Palm-size PC User’s Guide.

N O T E

To disconnect the Nino from the PC, take it out of the Nino Dock.
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About Synchronization

You can synchronize your Nino and your desktop PC to make sure 
that both devices have the most up-to-date information.

Synchronization starts automatically when you put the Nino in 
the Nino Dock (if you left the “Automatically synchronize upon 
connecting” option checked when you established the Nino-PC 
partnership). Exactly what gets synchronized depends on the 
settings you choose from ActiveSync Options on the Tools menu in 
the Mobile Devices window. 

What can get synchronized?

Contacts, Calendar, and Tasks—Information stored in these 
programs on your Nino is synchronized with Schedule+ or Outlook 
on your desktop computer. The most recently modified 
information, wherever it resides, replaces the older information.

Inbox Messages—Messages in Exchange or Outlook on your 
desktop computer are copied to your Nino. Messages you created 
on your Nino are stored in your Outbox and transferred to your 
desktop for transmission. 

Files—Files in NoteTaker and Voice Recorder on your Nino are 
synchronized with files in the My Documents folder (Windows 
95), or your Personal folder (Windows NT) on your PC. 

Channel Information—The most recent information for the 
channels you subscribe to on your PC is downloaded to your Nino. 
(A “channel” is an Internet information service that automatically 
sends out news, stock updates, or other information of interest.) 
If you also receive channel information on your Nino, these two 
sources are merged and only the most recent information appears 
on the Nino.

Resolving conflicts

If an item such as a task or appointment has been modified on both 
your desktop PC and your Nino, you’ll need to decide which version 
you want to keep. You can do this automatically or manually. See the 
Microsoft Palm-size PC User’s Guide for details.
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Using the Nino

The Quick Start buttons are configurable. To assign a different 
program to a button, tap Start > Settings > Buttons > Program tab. 

Button combinations: You can press and hold one button, and 
then press a second button to produce certain results. 

Stylus calibration: Press and hold the Exit button. Then press the 
Action button.

Tab: Press and hold the Action button. Then press the Scroll Up 
control.

Back tab: Press and hold the Action button. Then press the Scroll 
Down control.

Microphone: Position yourself about 20 cm (8 inches) away from 
the microphone when recording a voice message or giving voice 
commands.

Speaker: Control the volume of the speaker by choosing 
Volume & Sound from the Settings menu.

One-handed operation: 
You can operate the buttons 
on the Nino with one hand, 
leaving the other hand free to 
use the stylus, or for some 
other task.

Quick Start buttons: 
If the unit is off, pressing a 
Quick Start button turns it 
on and starts a program. If 
the unit is on, pressing one of 
these buttons switches to a 
different program.

First (top) button–Voice Recorder

Calendar

Contacts

Tactile dots let you identify each 
button with your fingertips.

Inbox
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Keeping your data safe

Your Nino comes with a non-removable, built-in lithium backup 
battery that will maintain the integrity of your data in the absence 
of other power sources. Note these important points:

■ You can check the status of the backup battery by tapping 
Start > Settings > Power.

■ It may take a few days of normal usage before this backup battery 
is fully recharged and appears as good. (It recharges when you 
are plugged in to AC power or when you are running the Nino 
on the rechargeable battery pack or AA batteries.) 

■ To prevent the backup battery from running down and failing to 
protect your data, do not leave the Nino for an extended period 
of time without AA batteries or the rechargeable battery pack 
installed, or without a connection to AC power. 

■ When AA batteries become low, replace them promptly. If the 
rechargeable battery pack is low, recharge it as soon as possible.

■ Don’t use NiCad rechargeable batteries with your Nino. 
Only use the Nino rechargeable battery pack or AA batteries.

Using a modem

You can use your Nino and a U.S. Nino Modem Click-on or a 
European Telephone Connectivity Kit (TCK) to connect to:

■ An Internet Service Provider (ISP) 

■ A corporate network through a Remote Access Server (RAS) 
connection

■ A remote desktop computer via RAS

■ A remote desktop computer via dial-up connection

Some U.S. models of the Nino include the Nino U.S. Modem 
Click-on. 

For your convenience, settings information about many ISPs is 
maintained at the Nino Web site at http://nino.philips.com.
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Nino input methods 

Keyboard Input Methods

Give yourself time to experiment with all these input methods for a 
few days to find the one or two you like best. 

Also built into your Nino is Pocket Commander, a voice command 
application that lets you navigate and control Nino software with 
verbal commands.

Windows CE keyboard T9 Text Input keyboard

The Windows CE keyboard is a replica of 
the familiar keyboard on your PC. Tap the 

 button to get the international 
character set.

The T9 Text Input keyboard is provided 
as a Nino software extra. As you tap, 
T9 matches the word you are entering. 
Larger keys make it easier and faster 
to enter information.

The Jot Character Recognizer included with 
Windows CE lets you write characters in a 
defined area on screen. With Jot, you need 
to learn to write the way the program 
expects characters to be formed.

Tap here to change the 
input method. 

The smARTwriter application 
provided as a Nino software extra 
lets you write anywhere on the 
screen. You can train the program 
to recognize your handwriting style.

smARTwriter
Handwriting Input Methods
Jot Character Recognizer
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First steps with T9

T9 Text Input lets you simplify and speed up tapped input. 
T9 provides large keys on an easy-to-read keypad.

To activate the T9 keyboard on the Nino, tap the arrow on the task 
bar to display the Input Methods menu. Then select T9 Text Input.

To change options for T9 (such as keyboard size), first make T9 the 
input method. Then tap Start > Settings > Input Panel > Options.

Full documentation for T9 is available on the Philips Nino CD. 
Click the Manuals tab on the Welcome screen.

You can tap anywhere 
on one of the nine keys.

T9 displays words 
matching the keys you’ve 
tapped so far. Usually 
your word will be first on 
the list. Tap Space to input 
the first word, or tap 
your intended word on 
the list.

The exact letters 
you’ve typed appear 
here. This is how you 
enter a word that might 
not yet be in the T9 
custom word database.

Or you can type precisely on a 
particular letter to add a custom 
word to the T9 database.

Tap here to display the 
Input Methods menu.
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First steps with smARTwriter

smARTwriter is a handwriting recognition program that lets you 
write input for any program anywhere on the Nino screen.

When you turn on your Nino, smARTwriter launches 
automatically and its icon appears in the icon tray in the inactive 
state. Tap this icon to activate  or inactivate  smARTwriter.

First use the Quick Trainer program to show smARTwriter how you 
make letters. Tap Start > Programs > smARTwriter > Quick Trainer. 
It takes five to ten minutes to complete a Quick Trainer session. 

Full documentation for smARTwriter is available on the Philips 
Nino CD. Click the Manuals tab on the Welcome screen.

N O T E If smARTwriter is active and you are experiencing diffi-

culty tapping a check box or using other Nino software controls, 

make smARTwriter inactive by tapping on its icon in the icon tray.

smARTwriter is active
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First steps with Pocket Commander

Pocket Commander is a voice command program that lets you 
navigate Nino software with spoken commands rather than by 
tapping with the stylus. 

The Pocket Commander recognizes the following commands:

After you give one of these general commands, Pocket Commander 
prompts you to give a second or third command to complete the 
operation. These additional commands are standard or uniquely 
determined by information such as contact or application names on 
your Nino. For example, to call Susan at work you would say three 
commands: “Dial” “Susan” “Work”.

To launch and use Pocket Commander, press and hold the second, 
third, or fourth Quick Start button on the right side of the Nino. 
The Pocket Commander icon appears in the icon tray. (You can also 
use the program by tapping this icon.)

Calendar—to open the Calendar 
application

Dial—to dial the phone number of 
a contact

Email—to generate an e-mail form 
preaddressed to a contact

Go To—to launch an application

Open—to open a file or note 

Read—to read back a contact’s 
phone number through the Nino 
speaker

Show Details—to display details 
about a contact

Voicemail—to generate an e-mail 
voice memo to a contact

Pocket Commander icon
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You must train Pocket Commander to recognize your 
pronunciation of commands. The first time you use the program, a 
message appears saying: “There are no trained activation words. 
Would you like to train them now?” Tap YES and then use the 
General Commands Training Wizard. 

N O T E You might choose to first train just a few commands and 

skip the others until you are familiar with how the program works. 

For a complete description of the Pocket Commander application, 
see the Pocket Commander manual on the Philips Nino CD. Click 
the Manuals tab on the Welcome screen.

First steps with Expense Manager

The Expense Manager application lets you conveniently keep track 
of your business or other expenses while you’re on-the-go. Later you 
can transfer the information to Excel on your desktop PC.

You can record information about hotel, car rental, food, or any 
other type of expense. You can also record hours and miles for a 
particular project or client.

For international work, Expense Manager lets you record values in 
local currency at the current exchange rate. The totals are 
automatically converted to your home currency.

To install the Expense Manager software on your Nino, follow 
these steps:

1 Put the Nino in the Nino Dock and insert the Philips Nino CD 
in your PC’s CD-ROM drive.

The Welcome screen appears automatically.

2 Click the Expense Manager tab at the top of the screen.

3 Follow the on-screen directions provided by the Expense 
Manager Setup program.

The software is installed on your Nino.

To launch Expense Manager tap Start > Programs > Expense 
Manager.
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Full documentation of the Expense Manager application is available 
on the Philips Nino CD. Click the Manuals tab on the Welcome 
screen.

First steps with Windows CE Software

The programs that are part of Windows CE include:

Other Windows CE applications include Calculator and Solitaire. 
(You’ll find them on the Programs menu.)

For more detailed information about these programs, see the 
Microsoft Palm-size PC User’s Guide.

To schedule appointments, 
meetings and other events

To see recent information from 
your channels 

To maintain a list of contacts, 
friends, and colleagues

To send and receive e-mail 
messages by synchronizing with 
Exchange or Outlook on your 
desktop computer, or by connect-
ing directly to an Internet service 
provider if your Nino has a modem

To write, sketch, and make lists

To keep track of what you have 
to do

To quickly capture your thoughts 
or other important information 
you need to reference later

Tap here to see the text menus 
in Windows CE applications

Tap here to hide the text menus
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Using Infrared Communications

You can use infrared (IR) beaming for wireless transfer of 
information between your Nino and another Nino, or any other 
Windows CE device that is IR-ready.

Some useful tips

■ Position the Nino IR port and the IR port of the other device 
so that they are lined up and within three feet (one meter) of 
each other.

■ Make sure that neither IR port is blocked.

■ Turn off fluorescent lights in the immediate area (some types 
of fluorescent lamps can interfere with IR communications). 
Or move to a location with different lighting.

Sending and Receiving

You can transfer notes, contacts, or voice recordings between 
devices when both are in the same program.

To send or receive contacts, choose the Contacts program and select 
one or more contacts from the list. Then tap on the menu control 
in the upper left corner to show the text menus. Then choose Send 
or Receive from the File menu.

To send or receive a note, go to the NoteTaker program, select a 
note from the list of notes, and then choose Send To and Infrared 
Recipient or Receive from the File menu.

To send or receive a voice recording, go to the Voice Recorder 
program, choose a recording from the list of voice recordings, and 
then choose Send To and Infrared Recipient or Receive from the 
File menu.

Tap here to see 
the text menus
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Adding a Data Storage Card

To install a CompactFlash data storage card in your Nino, follow 
these steps:

1 Open the door to the CompactFlash data storage card 
compartment on the back of your Nino. 

Push the door up and then flip it up. (The Nino can be on or off.)

2 Identify the connecting edge of the card. (There may be an 
arrow symbol on the card to help you do this.)
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3 Insert the CompactFlash card.

The ridge on the back edge of the card should be facing up. 
(This allows you to easily remove the card when you need to.) 

4 Close the door.

You now have the option of saving data to the card. In NoteTaker, 
for example, create a new note and then choose Save As from the 
File menu. Tap Option and then the location arrow to choose the 
storage card.
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Taking Care of Your Nino

General handling

Avoid dropping the Nino. Keep it away from extremes of hot or cold.

Screen care

Use only the Nino stylus to write or tap on the Nino screen. Using a 
pen or other sharply pointed object can cause damage. Protect the 
screen from scratches by keeping the unit in the pouch provided. 

Battery management 

Conserve battery life by taking these steps:

■ Recharge the batteries while you’re on the road by plugging in 
the Nino with the AC adapter whenever circumstances permit. 

■ Change your Nino’s default shut-off time when running on 
batteries. The default is three minutes. Choose Power from the 
Settings menu and then choose the Power Off tab.

■ Set the backlight feature to turn off automatically when running 
on battery power. Choose Display from the Settings menu.

■ Disable sounds you don’t need to hear. Choose Volume & 
Sounds from the Settings menu.

Memory and task management

Manage the amount of memory allocated to programs and storage. 
Choose System from the Settings menu and then choose the 
Memory tab. You can end a task (program), or switch to a different 
task from the Task Manager tab.

Cleaning and maintenance

Clean your Nino casing with a damp, soft cloth. To clean the 
screen, turn off the unit and then use a damp cloth or a moistened 
pad designed specifically for computer monitor screens.

And finally...

For worry-free use of your Nino, dock it whenever you’re near your 
PC. This recharges the batteries (if your Nino Dock is plugged in to 
AC power), and synchronizes information with your PC. Docking 
frequently protects your data.
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Troubleshooting

I can’t see anything on the Nino screen.

Make sure the unit is on and adjust the screen contrast.

Tapping or using other software controls doesn’t 
seem to work.

If smARTwriter is active, make it inactive by tapping its icon in the 
icon tray.

I get a screen message saying the backup battery is 
running low and I should replace it.

The rechargeable backup battery on the Nino is not removable. 
Dock the Nino or plug it in with the AC adapter in order to 
recharge the backup battery.

Tapping the screen doesn’t seem to work or produces 
unexpected results.

You may need to recalibrate the Nino. Hold down the Exit button, 
and then press the Action button to display the Calibration screen.

The Nino screen is frozen and nothing happens when 
I tap the screen or press the Quick Start buttons.

Using the end of a paperclip, press the Soft Reset button on the 
back of the unit. This restarts the Nino without erasing any stored 
information. 

Even after pressing the Soft Reset button, the screen 
is still frozen.

Remove the batteries. Plug in the Nino to AC power and then use 
the end of a paperclip to press the Soft Reset button on the back of 
the unit.

My battery doesn’t last long enough.

See Battery Management in the previous section of this guide.

If you can’t find an answer to your problem here, in the Microsoft 
Palm-size PC User’s Guide, from on-line Help, or at the Nino or 
Microsoft Windows CE Web sites, call Philips for telephone 
support. Refer to the Philip’s Support Card that comes with your 
Nino for the phone number nearest your location. 
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Nino Specifications 

Processor ■ MIPS-based Philips 32-bit RISC processor @ 75 MHz

System memory ■ RAM - 4 MB or 8 MB EDO RAM
■ ROM - 8 MB Fast Page Mode ROM

Dimensions/weight ■ Size: approx. 134 x 87 x 20mm (5.25" x 3.41" x .75")
■ Weight: approx. 220 g (7.8 oz.) with batteries

Communications ■ Integrated low power 19.2-Kbps data/fax modem included 
on the 320 model

Expansion ■ 1 CompactFlash Card slot
■ Replaceable ROM

Display ■ Low power, transflective LCD display (320x240 pixels, 0.24 mm 
dot pitch), 4 shades of gray

■ High brightness Electroluminescent (EL) Backlighting
■ Touchscreen
■ Contrast control dial
■ Indicator lights for Charging and Alarm/Message status

Power ■ NiMH battery pack, or 2 AA batteries
■ Built-in fast charger for battery pack
■ DC Power Jack
■ CR2025 lithium backup battery (rechargeable, nonremovable)

Audio ■ Audio In (unidirectional microphone)
■ Windows 95-compatible sound compression: up to 16 minutes 

recording time per 1 MB
■ Audio Out for .wav file playback and DTMF generation 

(auto dialing)

System I/O ports ■ RS-232 serial up to 115 Kbps
■ IrDA infrared transceiver, supports up to 115 Kbps

User Input ■ 4 Program buttons
■ Rocker switch for scroll up and scroll down
■ Action and Exit buttons
■ Stylus
■ Voice

Software ■ Microsoft Windows CE for the Palm-size PC
■ T9 text input by Tegic Communications, Inc.
■ smARTwriter handwriting recognition by Advanced Recognition 

Technologies, Inc.
■ Pocket Commander voice command by Advanced Recognition 

Technologies, Inc. 
■ Expense Manager
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Regulatory information

Declaration of conformity

This device complies with Part 15 of the FCC rules. Operation is subject to 
the following two conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.

FCC warning statement

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate 
radio frequency energy. If not installed and used in accordance with the 
instructions, it can cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a 
particular installation. Determine if the equipment does cause interference 
to radio or television reception by turning the equipment off and on. 
The user is encouraged to try to correct the interference by one or more 
of the following measures:

1. Where it can be done safely, reorient or relocate the receiving antenna.

2. Increase the separation between the equipment and receiver.

3. Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connected.

4. Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment. Shielded interface 
cables must be used when operating this device or the user’s authority to 
operate this equipment could be voided.

Industry Canada Statement

This Class B device meets all requirements of the Canadian Interference-
causing equipment regulations.  

Cet appareil numérique de la Class B respecte toutes les exigences du 
règlement sur le matériel brouilleur du Canada.

Responsible Party Name Philips Mobile Computing Group

Telephone 1-888-275-8356

Product/Model Nino 
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VCCI Class 2 Statement
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